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CALIBRATION PROCEDURE

SCXI"-1600

This document contains information about calibrating the SCXI-1600
module. This document does not discuss programming techniques or
compiler configuration.

NI-DAQmzx contains online help files that have compiler-specific
instructions and detailed function explanations. You can add these
help files when you install NI-DAQmx on the calibration computer.

You should calibrate the SCXI-1600 at a regular interval as defined by
the measurement accuracy requirements of your application. National
Instruments recommends that you perform a complete calibration at least
once every year. You can shorten this interval to 90 days or six months.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

bold Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and hardware labels.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction
to a key concept. This font also denotes text that is a placeholder for a word
or value that you must supply.

monospace Monospace text denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.
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Software

Calibration requires the latest version of NI-DAQmx, which includes
high-level function calls to simplify the task of writing software to calibrate
devices. NI-DAQmx supports many programming languages, including
LabVIEW, LabWindows™/CVI™, Microsoft Visual C++, Microsoft Visual
Basic, and Borland C++.

Documentation

The following documents are your primary references for writing your
calibration utility.

e The NI-DAQmx C Reference Help includes information about the
functions in NI-DAQmx.

e The DAQ Getting Started Guide provides instructions for installing
and configuring NI-DAQ devices.

e The SCXI Quick Start Guide includes information for installing and
configuring the SCXI-1600.

e The NI-DAQmx Help includes information about creating applications
that use NI-DAQmx.

For more information about the SCXI-1600, refer to the SCXI-1600 User
Manual.

Test Equipment

Figure 1 shows the test equipment you need to calibrate the SCXI-1600.
The specific connections are described in the Calibration Process section.

SCXI-1600 Calibration Procedure 2 ni.com



1 SCXI-1600 4 BNC to Banana Plug Adapter
2 USB Cable (as short as possible) 5 Calibrator
3 BNC Cable (as short as possible)

Figure 1. Calibration Connections

When calibrating the SCXI-1600, NI recommends that you use the
following:

e Calibrator—Fluke 5700A. If that instrument is unavailable, use a
high-precision voltage source that is at least 10 ppm.

e BNC cable—Use shielded BNC cables for the most accurate
calibration.

Test Considerations

Connection and environmental considerations:

*  Keep connections to the SCXI-1600 as short as possible. Long cables
and wires can act as antennae, which could pick up extra noise that
affect measurements.

»  Use shielded copper wire for all cable connections to the SCXI-1600.
Use twisted-pair wire to eliminate noise and thermal offsets.

*  Maintain an ambient temperature of 18 to 28 °C. (The SCXI-1600
temperature will be greater than the ambient temperature.)
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Keep relative humidity below 80%.

Allow a warm-up time of at least 30 minutes to ensure that the
measurement circuitry is at a stable operating temperature.

Calibration Process

This section provides instructions for verifying and calibrating the
SCXI-1600.

Calibration Process Overview

The calibration process has the following steps:

Initial Setup

SCXI-1600 Calibration Procedure

L.
2.
3.

Initial Setup—Configure the SCXI-1600 in NI-DAQmx.
Self-Calibration—Perform an internal calibration.

Verification Procedure— Verify the existing operation of the
SCXI-1600. This step allows you to confirm that the SCXI-1600 was
operating within its specified range prior to calibration.

Adjustment Procedure—Perform an external calibration that adjusts
the SCXI-1600 calibration constants with respect to a known voltage
source.

Perform another verification to ensure that the SCXI-1600 is operating
within its specifications after adjustment.

These steps are described in detail in the Initial Setup, Verification
Procedure, and Adjustment Procedure sections.

NI-DAQmx automatically detects the SCXI-1600 and configures the
chassis. However, for NI-DAQmx to communicate with the SCXI-1600,
it must be configured in NI-DAQmx.

Complete the following steps to configure the SCXI-1600 in NI-DAQmx.

L.
2.

AN

Install the NI-DAQmx software.

Connect the USB cable from the computer port to the USB port on the
SCXI-1600.

(Optional) Attach the cable to the strain relief using a cable tie.
Launch Measurement & Automation Explorer (MAX).
Expand Devices and Interfaces.

Expand NI-DAQmzx Devices.

4 ni.com



7. Expand the chassis where the SCXI-1600 module is located.

8. Right-click the chassis containing the SCXI-1600, and select Test to
ensure that the SCXI-1600 is working properly.

Self-Calibration

Call self-calibration before doing the first verification. This function
measures the onboard reference voltage of the device and adjusts the
self-calibration constants to account for any errors caused by short-term
fluctuations in the operating environment. When you self-calibrate a
device, no external signal connections are necessary.

NI-DAQ Function Call LabVIEW Block Diagram

Call pAQmxSelfCal with the
following parameters:

Device_Name[]: dev1l

Verification Procedure

Verification determines how well the SCXI-1600 meets its specifications.
By completing this procedure, you can see how the SCXI-1600 performed
since its last calibration. You can use this information to help determine the
appropriate calibration interval for your application.

The verification procedure is divided into the major functions of the
SCXI-1600. Throughout the verification process, use Table 1 to determine
if the SCXI-1600 needs adjustment.

Analog Input Verification

Since the SCXI-1600 has many different ranges, you must check
measurements for each available range.

Complete the following steps to check the performance of the analog input.

1. Connect a BNC cable between the EXT CAL BNC connector on the
SCXI-1600 front panel and the calibrator.

2. If your calibrator has a guard connection, leave it unconnected.

Table 1 shows all acceptable settings for the SCXI-1600. Although NI
recommends that you verify all ranges, you can save time by checking
only the ranges used in your application.

Set the calibrator voltage to the test value indicated on Table 1.

5. Create a task using DAQmxCreateTask.

© National Instruments Corporation 5 SCXI-1600 Calibration Procedure



NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQmxCreateTask with the
following parameters:

taskName: AIVerificationTask
taskHandle: staskHandle

LabVIEW does not require this step.

6. Add a channel to the task using DAQmxCreateAIVoltageChan
(DAQmx Create Virtual Channel VI) and configure the channel.
Use Table 1 to determine the minimum and maximum values for the
SCXI-1600.

NI-DAQ Function Call

LabVIEW Block Diagram

Call
DAQmxCreateAIVoltageChan
with the following parameters:

taskHandle: taskHandle
physicalChannel:
devl/_extcal
nameToAssignToChannel:
myVoltageChannel
terminal Config:
DAQmx_Val_Cfg_Default
minVal: -10.0

maxVal: 10.0

units: DAQmx_Val_Volts
customScaleName: NULL

inirmum value ¥
airmurn Yalue ¥

"Task Qut" oukput to next
YI's "Task In" input

Physical Channel

"Error Cut" Dutput ko mexk

WI's "Error In" input

Physical Channel Control drop-down list.

If you have not previously enabled internal channels in LabVIEW, double-click the AI Voltage VI, right-click the Physical
Channel Control and select I/O Name Filtering, and then check Internal Channels to make _extcal show up in the

7.

Configure timing for the voltage acquisition using

DAQmxCfgSampClkTiming (DAQmx Timing VI).

SCXI-1600 Calibration Procedure
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NI-DAQ Function Call

LabVIEW Block Diagram

Call
DAQmxCfgSampClkTiming
with the following
parameters:

taskHandle: taskHandle
source: NULL

rate: 100000.0
activeEdge:
DAQmx_Val_Rising
sampleMode:
DAQmx_Val_FiniteSamps
sampsPerChan: 10000

"Taskfchannels in" input from
previous YIs

"Error in" input From previous
WI's “error ouk" oukput

pet Zhannel

Finite Samples *

"Task out" oukput to next
WI's "task in" input

kask out" output

}

Sample Clock = |P

"Error out" oukput o nexk
WI's "error in" input

8. Start the acquisition using DAQmxStartTask
(DAQmx Start Task VI).

NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQmxStartTask with
the following parameter:

taskHandle: taskHandle

"Taskjchannels in" input From
previous YI's

"Error in" input from previous
WI's "error ouk" oukput

"Task aut" oukpuk ko nexk
WI's "taskichannels in" input

kask ouk" oukput

=="Errar out" oukput to nexk
WI's "error in” input

9. Acquire 10,000 points of voltage data using DAQmxReadAnalogF64

(DAQmx Read VI).
NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxReadAnalogF64 with
the following parameters: "Task/channels| Fimeout Data Out| "Task oot

) in" inpuk From ! koe]| joubput bo
taSkHandle. taskHandle FIrEVil:ILIS I'."IIS nexk I'."IIS
numSampsPerChan: -1 "kask, out" "kask channels
timeout: 10.0 oukpuk in" inpuk
fillMode: By =

m 1 n
DAQmx_Val_GroupByChannel "Errar in" input e Errar aut
readArray: data From previous N”ght'g e M »|  loukput ko nesxt
arraySizeInSamples: 10000 WI's "error oot an Foamp YI's "error in"
sampsPerChanRead: sread output input
reserved: NULL
© National Instruments Corporation 7 SCXI-1600 Calibration Procedure



10. Average the 10,000 voltage values. Compare the resulting average to
the upper and lower limits listed in Table 1. If the result is between
these values, the analog input is verified.

11. Clear the acquisition using DAQmxClearTask
(DAQmx Clear Task VI).

NI-DAQ Function Call LabVIEW Block Diagram

Call DAQmxClearTask with the following

parameter; Task in" input From previous

YI's "task aut" oukput
taskHandle: taskHandle

"Errar in" input From previous

WI's "error ouk" oukput

12. Repeat steps 4 through 10 until all values are verified.
13. Disconnect the calibrator from the SCXI-1600.

You have finished verifying the analog input levels on the SCXI-1600.

Adjustment Procedure

Use this adjustment procedure to adjust the analog input calibration
constants. At the end of each calibration procedure, these new constants are
stored in the external calibration area of the EEPROM. The values in the
EEPROM are password-protected, which prevents the accidental access or
modification of any calibration constants adjusted by the metrology
laboratory. The default password is NT.

Perform adjustment of the SCXI-1600 with a calibrator by completing the
following steps:

1. Connect a BNC cable between the EXT CAL BNC connector on the
SCXI-1600 and the output of the calibrator.

2. Set your calibrator to output a voltage of 7.50 V.

Open a calibration session on the SCXI-1600 using
DAQmxInitExtCal (DAQmx Initialize External Calibration VI).
The default password is NI.
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NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQmxInitExtCal
with the following
parameters:

deviceName: dev1l
password: NT
calHandle: scalHandle

"Calhandle out" output bo next
WI's "calhandle in" input

abc K

[Dagme: Initialize External Calibration vi]

"Errar ouk" aukput ko nexk
WI's “erraor in® inpuk

4.

Perform an external calibration adjustment using
DAQmxESeriesCaladjust (DAQmx Adjust E-Series
Calibration VI).

NI-DAQ Function Call

LabVIEW Block Diagram

Call
DAQmxESeriesCalAdjust
with the following
parameters:

calHandle: calHandle
referenceVoltage: 7.5

eference voltage

k

"Calhandle in" input from last
YI's "calhandle out” oukpuk

"Calhandle out” aukput ko nesxk
WI's "calhandle in" input

"Error in" input From last
WI's "error ouk" oukput

="Error ouk" oukbpuk o nexk
WI's “errar in® inpuk

[Dame: Adjust E-Series Calibration.vi]

Save the adjustment to the EEPROM, or onboard memory, using
DAQmxCloseExtCal (DAQmx Close External Calibration). This
function also saves the date, time, and temperature of the adjustment
to the onboard memory.

NI-DAQ Function Call

LabVIEW Block Diagram

Call DAQmxCloseExtCal
with the following
parameters:

calHandle: calHandle
action: DAQmx_val__
Action_Commit

"Zalhandle in" input From last
WI's "calhandle out” output -

"Erraor in" input From last

WI's "errar out” autput DaCm: Close External Calibration. i

6.

Disconnect the calibrator from the SCXI-1600.

The SCXI-1600 is now calibrated with respect to your external source.

© National Instruments Corporation
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After calibrating the SCXI-1600, NI recommends reverifying the analog
input operation. To do this, repeat the Verification Procedure section using
the 24-hour test limits values from the SCXI-1600 Test Limits section.

SCXI-1600 Test Limits

Using the Table

SCXI-1600 Calibration Procedure

Table 1 lists the specifications for the SCXI-1600. and displays the
specifications for both 1-year and 24-hour calibration intervals. The 1-year
ranges display the specifications that the SCXI-1600 should meet if it has
been one year between calibrations. When an SCXI-1600 has been
calibrated with an external source, the 24-hours ranges are the valid
specifications.

The following definitions describe how to use the information from
Table 1.

Range

Range refers to the maximum allowable voltage range of an input or output
signal.

Test Point

The Test Point is the voltage value that is input or output for verification
purposes. This value is broken down into two columns: Location and
Value. Location refers to where the test value fits within the test range.
Pos FS stands for positive full-scale and Neg FS stands for negative
full-scale. Value refers to the voltage value to be verified and is in volts.

24-Hour Ranges

The 24-Hour Ranges column contains the Upper Limits and Lower Limits
for the test point value. That is, when the SCXI-1600 is within its 24-hour
calibration interval, the test point value should fall between the upper and
lower limit values. Upper and lower limits are expressed in volts.

1-Year Ranges

The I-Year Ranges column contains the Upper Limits and Lower Limits
for the test point value. That is, when the SCXI-1600 is within its 1-year
calibration interval, the test point value should fall between the upper
and lower limit values. Upper and lower limits are expressed in volts.

10 ni.com



SCXI-1600—16-Bit Resolution

Table 1 includes values for the SCXI-1600 analog input.

Table 1. SCXI-1600 Analog Input Values

Range (V) Test Point 24-Hour Ranges 1-Year Ranges
Lower Upper Lower Upper
Minimum Maximum Location Value (V) Limit (V) Limit (V) Limit (V) Limit (V)
-10 10 Pos FS 9.900 9.8929 9.9071 9.8925 9.9075
-10 10 0 0.000 -0.0017 0.0017 -0.0017 0.0017
-10 10 Neg FS -9.900 -9.9071 -9.8929 -9.9075 -9.8925
-5 5 Pos FS 4.950 4.9484 49516 4.9482 49518
-5 5 0 0.000 -0.0009 0.0009 -0.0009 0.0009
-5 5 Neg FS -4.950 -4.9516 —4.9484 -4.9518 —4.9482
-0.5 0.5 Pos FS 0.495 0.49462 0.49538 0.49460 0.49540
-0.5 0.5 0 0.000 —-0.00011 0.00011 -0.00011 0.00011
-0.5 0.5 Neg FS —0.495 —0.49538 -0.49462 -0.49540 -0.49460
-0.05 0.05 Pos FS 0.0495 0.049441 0.049559 0.049439 0.049561
-0.05 0.05 0 0.000 -0.000032 0.000032 —-0.000032 0.000032
-0.05 0.05 Neg FS -0.0495 —0.049559 —0.049441 —-0.049561 —0.049439
National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section onni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
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© 2004-2005 National Instruments Corporation. All rights reserved. 370570B-01 Julos




	SCXI-1600 Calibration Procedure
	Conventions
	Software
	Documentation
	Test Equipment
	Figure 1. Calibration Connections

	Test Considerations
	Calibration Process
	Calibration Process Overview
	Initial Setup
	Self-Calibration
	Verification Procedure
	Analog Input Verification

	Adjustment Procedure

	SCXI-1600 Test Limits
	Using the Table
	Range
	Test Point
	24-Hour Ranges
	1-Year Ranges

	SCXI-1600-16-Bit Resolution
	Table 1. SCXI-1600 Analog Input Values



